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1.Introduction

1.1 Overview of Lab

The goal of this lab is to take Event Frames that represent batch runs, create upper
and lower bounds for those runs, and to create a calculation to alert us to when a
new batch is out of range.

@

O pivision © New Display
@

Events

Automaticaly refresh the list

‘Wellness Rx Upper Limit
V12019 12:00:00 AM - 2172019 1:01.00 AM

Wellness Rx Lower Limit

Wellness Rx Avg

& WN-CHEM-RX100:20180823 13:48 (Prod B)
V312018 11:47:37 PM - 2172018 12.48:37 AM

>

¥ WN-CHEM-RX300:20180823 13:48 (Prod B) bd
© WN CHEM RX200:20180823 1348 (Prod B) > I L RN A R A A

>

>

>

@ WN CHEM RX400° 20180823 1348 (Prod D)
O 'WN-CHEM-RX100:20180823 13:48 (Prod A)
Ay

HEM:RX200: 20180823 13:48 (Prod B)

W i e e Rvans Anannann 1n

Visiness Rx Uppes Limt
Attributes Visinees R Lower Limi
WN:CHEN RX100:20180823 1348 (Prod B) isinss o Aug
Aghatior 4+ 4 ViN-CHEM RX100-20180823 1348 (Prod B
i Agitation: 0

+ 7 VN CHEM RX300:20180823 1348 (Prod
£ Avg Agitation: 102.94 rpm

4+ O VN CHEM RX200- 20130823 13 45 {Prod B
Batch Info

+ & Vi CHEMRXA0020180823 1348 (Prod D
=] Recipe: Recipe 456 e

4+ [ VN CHEM RX100:20130823 13 48 {Prod A)
Event Details R
=] Referenced Element: RX100 i e R e P
o s—— T U CHEw R0 20180823 1346 Prod
5] BatchiD: WN:CHEM.RX100:20180823 1348 A ViN CHEM RX 10020180623 13.48 (Prod A
& Procedure: SHORT + 4 WN.CHEM RXA00:20180823 13 48 (Prod D

1.2 Tasks

We start this lab with our Event Frames for a batch run in a reactor, all beginning
with “WN:CHEM:RX.” The steps we will take are as follows:

1. Publish Pl Event Frames to a statistical engine
o Using the Pl Integrator for Business Analytics
2. Calculate Statistics
o Using Microsoft SQL Server Management Studio
o Output data to csv file and pipe data back into PI
3. Create Upper and Lower Limit Event Frames
o Manually using PI System Explorer or automatically with Pl Builder
4. Visualize
o Create a Pl Vision overlay display where we can track live batches against historical SPC
values
5. Alarm
o Create a Pl Analysis that will trigger a notification if the values fall outside of control

6|Page



Introduction

1.3 Identify Breakdown of Lab Content

Your objectives in this section are:

Objective 1. Learn how to publish data using the PI Integrator for Business Analytics
Objective 2. Learn how to create statistical data with Microsoft SQL Server

Objective 3. Do basic modelling in Pl Asset Framework and learn how to create
Event Frames

Objective 4. Visualize Event Frames in PI Vision

Objective 5. Create a Pl Analysis to compare live running batches to the statistical
limits

Objective 6. Create a Pl Notification based on the previous Pl Analysis (if there’s
time)
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2. Directed Activity — Investigate Event Frames

2.1 Objective of Activity

Look at the event frames that we already have in the Pl System using Pl Vision and investigate the AF

database

2.2 Identify the Tasks

e Open PI Vision

e Do an Event Comparison

2.3 Step by Step

a. Open Google Chrome Once Google Chrome is open, navigate to
https://pisrv01/pivision/#/. Feel free to use the bookmark or quick link.

b. Click on the display titled “Reactor”

c. Click on events

*

ge

d. Right click > select ‘Compare Similar Events by Type’

€. Save our new event comparison displa

Temperature (°C) X
[140

F120

Best Practice

Make this display public so that others in the organization can also use it
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https://pisrv01/pivision/#/

3. Directed Activity — Publish Data using the PI
Integrator for Business Analytics

3.1

In order to create the high and low limit EFs, we’ll need to cleanse the data, augment it, shape it into a
table, and transmit to a calculation engine. The PI Integrator for Business Analytics will allow us to do

this.

3.2

e.

Objective of Activity

Identify the Tasks

Open the PI Integrator for Business Analytics

Select the Event Frames and Attributes of Interest

Edit Value Mode to Sampled Values, sampling every 10 seconds
Add column Event Frame Relative Time Seconds to the dataset
Publish to SQL

Select Data

In Google Chrome, click the PI Integrator for Business Analytics bookmark

Select “Create Event View”

+ Create Asset Vi
Build ad 1a view st= ting with

+ Create Event View + Create Streaming View

your event frame hierarchy custom output shape

Make sure the Database is set to “OSIPharma”

Select any Event Frame from the list that starts with WN* and into the Event Shape

Select Data > Modify View > Publish

" Source Events + "t Search Shape
"8 Event Shape

Sy PISRVO1

*# WN:CHEM:RX100:20180101 0:17 &S x
drdm OSIPharma o

I T | Enter Event name or string match pattern ‘

Event Frames Assets

‘ » "8 WN:CHEM:RX100:20180101 0:117 ‘

Click and drag the attributes Agitation and Temperature under the event

4 Md WN:CHEM:RX100:20180101 0:17 &S X
& Agitation &S x
& Temperature &S %
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f. Select the ¢ button next to the Event Frame to Edit Filters

4 B wWN:CHEM:RX100:20180101 0:17 x
& Agitation & =
& Temperature # R

g. Change Event Frame name to search for WN:* and click save

Edit Filters x

Show Wildcard Groups »

#| Event Frame Name

W™

h. We should now see “Found 100+ Matches” on the right. Click “Next” in the top
right

Catchup # L PISCHOOL\student01

"8 Search Shape + Matches
"H Event Shape Found 100+ Matches
4 PR WN S x » "8 WN:CHEM:RX200:2019103 23:33
& Agitation S n » "8 WN:CHEM:RX300:2019103 23:34
& Temperature # % » "8 WN:CHEM:RX100:2019103 23:47

» "H WN:CHEM:RX400:201921 0:01
» "d WN:CHEM:RX200:201921 0:46
» "“H WN:CHEM:RX300:201921 0:49

» "8 WN:CHEM:RX100:201921 0:58
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3.4 Modify View

a. Change the Start time and End Time to 1/1/2019 and 3/1/2019 and click Apply

Start Time End Time

‘ 1112019 ‘ ‘ 3112019 ‘

b. Click
1. Add Column
2. Time Column
3. The Dropdown
4, Event Frame Relative Time

Add Column ’/
=

Data Column Time Column Static Value
1 I I f =4
Select Time Column Options for| Local < v

Year (2 Local Event Frame Start T
Month GMT Event Frame End Tit
Month Name TimeStamp

Week of the Year Event Frame Start Time (Local) Event Frame Duratic
D,

. Event Frame End Time (Local) €

Day of the Week

Hour (14 Event Frame Start Time (GMT) | 2

Minute (24

Event Frame End Time (GMT)

Second

Milliseconds (274 Event Frame Duration

b A Event Frame Relative Ti /1

UTC Milliseconds (155 e FEe BE ME (]

Ticks 75 Event Frame Time Delta

Time Zone Offset (4

c. Select “Seconds” from the list on the left and click them® button to add it

d. The List of Time Columns should now look like this:

Event Frame Start Time (Local) TimeStamp (Event Frame Start Ti
Event Frame End Time (Local) TimeStamp (Event Frame End T
Local TimeStamp (Local

Event Frame Duration Hour (Event Fram

Event Frame Relative Time Second (Event Frame Relztive Time)

Display 5 time columns

e. Click “Display 5 Time Columns”
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f. Click
1. Edit Row Filter

2. Select “Numeric” Filter

Row Filters x

Add New Row Filter

Include rows based on whether the contents of a column match a

Strin
L string pattern

Include rows based on whether the contents of a column contain
certain digital values

Numeric ') Include rows based on whether the contents of a column contain
certain numeric values

Include rows where the contents of a column contain a val
Null Values clude ere ontents of a col ontain a value

Include rows where certain Event Frames are active

Close

3. Use the drop downs to set a filter to Include rows where Event Frame Relative Time
Second is less than or equal to 3660

Add Numeric Row Filter x

% Include rows where all of these conditions are true
Include rows where any of these conditions are true

Event Frame Relative Time ¢ ¥ || less than orequalto ¥ |[3660

=+ Add Another Filter Criteria

Cancel Save Numeric Row Filter
4. Save Numeric Row Filter
5. Click Close
Row Filters x

Numerie Filter 1 Sx Add New Row Filter

Include rows based on whether the contents of a column
match a string pattern

Include rows where all of these conditions are
true

Include rows based on whether the contents of a column
contain certain digital values

Event Frame Relative Time Second <= 3660

Include rows based on whether the contents of a column
contain certain numeric values

Numeric

Include rows where the contents of a column contain a
value

MNull Values

Include rows where certain Event Frames are active
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g. Click
1. Edit Value Mode
2. Sampled Values
3. Set to Sample Every 10 Seconds
4. Save Changes

Edit Value Mode

Summarized Values
)‘ Sampled Values
® Sample val 24
ample values every | 10 = || seconds~ | =
=
® Interpolate €@
Exact @

Use Key Column[Agitation ]
1

Save Changes

h. We should now see the Event Frame Relative Time Second incrementing by 10 for
each row

Event Frame Relative Time Second

0 C
10 1
20 z
30 G
40 i
20 &
&0 1
70 1

i. Select “Next” in the top right
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3.5 Publish

a. Use the Dropdown Under “Target Configuration” and Select “SQL Server”

Select Data » Modify View > Publish

Target Configuration Summary

S0L Server v Shape and Maiches

Pl View s There are 100+ Matching Instances

Timeframe and Interval
SQL Server

» Your Start Time is 2/1/2019

Text Qutput + Your End Time is 3/1/2019

+ Your Time Interval gets an interpolated measurement Every
10 seconds

b. Ensure the Summary shown looks identical to the one above

d. This will take you back to the home screen where we can monitor the progress of our

Eublication

c. Click “Publish”

Name Run Status. Type Run Mode Stat Time. End Tume

BalchRLS Mot Yel Fublished E Once 1218 2019 el
wsbec  Eem e
= —mn
=~ Loy  Secuily  ViewCoofigustion  Statistics
Run Status Publishing 32% Publish Actions Search Shape

— — .
b coti e S ot e

PIAF Database.

Publish Target AL Server
View Type Event o
Run Mods

Last Run Time.

Yeur Start Time is
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3.6 Notes on this Activity and Options

This Section focuses on getting our data to a point that we can do some analytics on the data.
We used the PI Integrator for Business Analytics because it is the easiest method to get our
batch data with relative timestamps and the associated temperature and agitation data into a
state where they can be calculated on. This is also possible to do with Pl DataLink, although
there are more steps involved and it is more time consuming. In broad terms, the steps are:

1. Get the pertinent batches’ (Event Frames’) start time and end time.

2. Find the associated attributes

3. Do a‘Sampled Data’ Pl Data Link query using the start time, end time, and 10s as the
interval, being sure the check the box to Show Timestamps

4. Take the timestamps and subtract them by the batch’s start time in order to get Event
Frame Relative Time

Also, we are publishing this data to MS SQL in order to do statistical calculations. Once again,
this was chosen as the easiest tool with which to do these calcs, but there are also options for
this as well that are enumerated in the next section.

Filtering:

For this lab, we are getting data on all Reactors for all Products. In a more real-world scenario,
we would likely want to use more of the “Edit Row Filters” options on the Maodify View page to
ensure that we are only publishing the appropriate batches. For instance, setting Product =
“Prod A” or Primary Element = “RX100” could be used. However, this can also be done in the
next section, when statistics are being created.
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4. Directed Activity — Create SPC Event Frame Data

4.1 Objective of Activity

In this activity, we’ll use Microsoft SQL to calculate statistical data for our lower, upper, and average SPC
Event Frames’ data. We can also use MSSQL to output these values to a file, that can be ingested into
the PI System

4.2 Identify the Tasks

e View published data
o Create statistical data
¢ Ingest into the Pl System
4.3 Step by Step — Calculate Statistics and place into PI
a. Open SQL Server Management Studio (pinned to taskbar)
b. Find the publication that we just created under the Databases > PIData > Tables
c. Right click and choose the “Select top 1000” option

d. View the results:

B Resuts [ Messages

d_WNS Event Frame Start Time {Local) TmeStamp ~ Event Frame End Time {Local) TmeStamp ~ Event Frame Duration Hour  Local TimeStamp Event Frame Relative Time Second  Agitation Temperature  PlinTSTicks PlintShapelD
1 {1 WNCHEM:RX200201910323:33  2019-01-31 23:33:37.000 20190201 00:34:37.000 1 20190131 233337000 0 0 0 636846032170000000 0
2 2 WNCHEMAX200201910323:33 20180131 2333:37.000 20190201 00:34:37.000 1 20190131 233347000 10 200342330932617 3 636846032270000000 0
3 3 WNCHEMRX200201910323:33  2013-01-3123:33:37.000 20190201 00:34:37.000 1 20190131 233357000 20 40.0834661865234 6 636846032370000000 0
4 4 WNCHEMRX200:201910323:33 20190131 23:33:37.000 20190201 00:34:37.000 1 20190131 23:3407.000 30 60.1026952797852 8 636846032470000000 0
5 5 1 [}

WN.CHEM:RX200:2019103 23:33  2019.01-31 23:33:37.000 20190201 00:34:37.000 20190131 23:34:17.000 40 80.1369323730469 11 636846032570000000

e. Next, open Folder on the Desktop titled “SQL_Queries”
f. Open all files within that folder

g. Start by looking at “Ave Temp-Std Dev-by EF relative.sql” and replace
“PublicationName” with the actual name of our publication

h. TIP: Use Ctrl+H to find and replace. Click = * D=t

[ Resutts 3 Messages

and View the results:

AVG_TEMP  StDev_Temp event frame relative time second
1o o 0
T NsssemE o
3 6 2.05712483878454 20
4 10 3.0568787255795 0
5 13 405680568573518 40
6 16 5.07217674824419 50
7 20 6.05520474000884 60
8 20 5.15837334178147 70
9 15 4511859927165881 80
m 19 A 2R1NARZANNIAZS 90
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i. Select the tab titled “Temperature Upper...”and again replace “PublicationName”
with our publication name

J. Click Execute

In the Results Area, Right click and Select “Save Results As...” and give it a

unique name, like “Upper” to the Desktop

~ e R =

Y T R =]
[EE R P =]

=~

a

I. Repeat steps |, j ,and k for files “” and “”

1 Resutts

_'_:1 Messages

temperature_upper_limit

temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit
temperature_upper_limit

bt

trmm b e

timestamp

2015-02-01 00:00:00.000
2015-02-01 00:00:10.000
2015-02-01 00:00:20.000
2015-02-01 00:00:30.000
2015-02-01 00:00:40.000
2015-02-01 00:00:50.000
2015-02-01 00:01:00.000
2015-02-01 00:01:10.000
20150201 00:01:20.000
20190201 00:01:30.000
20190201 00:01:40.000
201902401 00:01:50.000
201902401 00:02:00.000
2019-02-01 00:02:10.000
201902-01 00:02:20.000
201802-01 00:02:30.000
2019-02-01 00:02:40.000

AAG 3 N4 ANAT-RN RN

files saved to the desktop.

Temp_upper_limit
0
5.08917103330865
10.1142436775639
16.113757451159
21.1136113714704
26.1443534564884
32 1184054800177
53 Copy

Copy with Headers

Select All
Save Results As...
0 Page Setup..
= Print...
28.0475725045512

28.5300506245343
23.0704613524235

N 2ECI1TI0ITIRT

Ctrl+C
Ctrl+Shift+C
Ctrl+A

Ctrl+P

. When finished we should have 3 new

Click and drag these files into the folder on the desktop labeled
“SQL_Input_Files.” A Pl UFL Interface has already been configured to take files from
this location and ingest them into the Pl System. The file extension will change from
.csv to ._OK once the file has been read

UFL was used to ingest this data into the Pl Data Archive, but there are
certainly other ways to get the data into Pl. The most prominent being

At PowerShell tools for the Pl System and piconfig
Tip
' Microsoft SQL was the chosen tool for this Lab, but many other tools can
— be used to create this data, including Microsoft Excel
Tip
From an Analytics point of view, we have made two critical choices for this lab:
' We chose to use the Average as a midpoint for the data. In a real setting, we
may want to use the median instead, as this is considered more robust. Also, we
’ have chosen to use two standard deviations to create our upper and lower limits.
Tip The number of standard deviations to use is ultimately up to you.
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5.Directed Activity — Create SPC Event Frames

5.1 Objective of Activity

Now that we have the data in the PI System, we need to map our new tags to Elements, and create
Event Frames for them

5.2 Identify the Tasks
¢ View Elements in Pl AF using PI System Explorer

e Create Event Frames for the golden batches

5.3 Create Event Frames

®
a. Open PI System Explorer (pinned to taskbar) - and see that we're connected to
AF Server PISRV01 and AF Database OSIPharma

b. Expand out Calcs and investigate the 3 elements beneath it, and select the attributes tab

c. We can see that the tags we just created are mapped to the temperature attribute, but

other tags still have not been created
Q YWPISRVOTI\OSIPharma - Pl System Explorer (Administrator)

File Search View Go Tools Help

@Database %] Query Date ~ (© @ Q) Back H, Checkln <) « [#] Refresh | (F Mew Element + =] New Attribute
Elements Wellness Rx_Reactor_Lower_Limit
5 Elements General  Child Elements  Attributes  parts  Analyses  Notification Rules  Version
= Calcs
H (F Wellness Rx_Reactor_Average
i |Eo"fer
9 wWellness Rx_Reactor_Lower_Li
: - [ Wellness Rx_Reactor_Upper_Li |y ¢ @/ & B Name alvalue
+ (G Wellness Rx
(L3, Element Searches =] Category: Batch Information
B m ’ 7 Active EPI Point not found "Wellness Rx_Reactor_Lo
0| ¥ BatchID P1I Point not found "WMN:CHEM: Wellness Rx_F
O B® | ¢F Batch Runtime Pt Created
0 m -l e el e AR R L R

d. Now that we have data and AF Elements, we need to create the Event Frames around
the data
CHOICE 1: Create Manually in PI System Explorer’s Event Frames Section. Right
click, New Event Frame, set Wellness Rx UnitBatch as the EF Template, 2/1/2019
12:00:00 AM as Start Time, 2/1/2019 1:01:00 AM as End Time, and setting the reference
element to one of the 3 above. Repeat for the other two reference elements

CHOICE 2: Create Automatically by opening the folder on the desktop titled “Catch up
Files”, Opening “EF_Creation.xIsx”, and selecting P| Builder tab and Publish
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6. Directed Activity — Create a Bounded Event Frame
Comparison view

6.1 Objective of Activity

Look at the event frames that we just created in Pl Vision, and create a display for them

6.2 Identify the Tasks

e Open PI Vision

¢ Add SPC Event frames to an Event Comparison view

6.3 Augment existing event comparison display

a. Open Google Chrome Once Google Chrome is open, navigate to
https://pisrv01/pivision/#/. Feel free to use the bookmark or quick link.

b. Click on the Event Comparison display we created earlier

c. Click on events E

d. Select “Edit Search Criteria”

e. Click on “Event Name” and Filter using Wellness* or the name of the Event Frames
we just created

Edit Search Criteria

OSIPharma

» Database
» Time Range Custom Time Range
» Event Severity

-
v Event Name ) Wellness*

—
Wellness™

» Event Type and Attribute Value Selected
» Asset Name Any
» Asset Type

» Event State

» Event Category

» Event Acknowledgment
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f.  When the SPC Event Frames we created are in the search bar, right click and select
“Pin Event” for each of the three.

Hide Event

Event Details

Compare Similar Events by Name
Compare Similar Events by Type

Pin Event

g. Once that is completed, erase the Event Name filter that we put into place in Step E.

h. We should now see real production batches and our SPC Event Frames on the same
display

@ * ® x|+ - 8 x

€ c ps//pisne01 % @
® @ Pl ltegrator for Bu.. % Oniine Surwey S0

O'pivision © newoispiay | [ |

@ Events

Automatically refresh the list

‘Welness Rx Upper Limil
212019 12:00:00 AM - 2172019 1:01.00 AM

Wellness Rx Lower Limit

Wellness Rx Avg

4 WN CHEMRX100:20180823 13:48 (Prod B)
A2019 11:47:37 PM - 2172019 124837 AM

>
¥ WN-CHEM-RX300:20180823 13:48 (Prod B} >
O WN CHEM RX200 20180823 1348 (Prod B) > e L U N N NP N NP T N N
@ WN-CHEM RX400 20180823 13:48 (Prod D) >

O WN-CHEM:RX100:20180823 13:48 (Prod A) t)

& WN.CHEMRX200:20180823 13:48 (Prod B} >

T a4 YAAR ARIANATA 748 Mo DY “

|10 et scoreh crtaria

Aftributes Wellness Rx Lower Limit
WN:CHENM RX100:20180823 1348 (Prod B) e
Aghation 4+ 4 N CHEM RX10820180823 1348 (Proa B
) Agitation: 0
+ ¥ N CHEM RX08:20100623 1248 (Proa
£ Avg Agitation: 102.94 rpm
4 O WN CHEM RX200:20180823 1348 (Prod B}
Batch Info SRS D fesht
= 4+ O N CHEM RX4D020180823 1348 (Proa )
ecipe: Recipe R
—_— 4+ 0 oy CHEM RX10020180523 1348 (Proa
Detai sy
£=] Referenced Element: RX100 e e R )
Information o ¥ VN CHEM RX30020160623 1348 (Frog B
] BatchiD: WN-CHEM RX100-20180823 1348 U CHEW RX10020100823 1349 Prod )
= Procedure: SHORT 4+ 4+ N CHEM RX400:20180823 1343 (Proa D)
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7.Directed Activity — Create a Pl Analysis comparing
current runs to SPC limits

7.1 Objective of Activity

Now that we have a visual view of the current batches, it would be great to have something automated
that would tell us if the current running batch is out of specifications

7.2 Identify the Tasks

e Open PI System Explorer

¢ Add a PI Analysis to the Wellness Rx_Reactor Template to write the status of
the current running batch, relative to the high and low limits

o Set to trigger when the ‘Temperature’ attribute updates
o Create output point

7.3 Add PI Analysis to Template
a. Open PI System Explorer

b. Navigate to Library > Element Templates > Wellness Rx > Wellness Rx_Reactor
Template and select the Analysis Templates tab.

Cc. Right click and select New

d. Give the Analysis a name like “Batch Temp Deviation”

e. Click the “Add a new variable” button so there are two places for expressions
f. Open the desktop folder “Catch up Files” and open file “7_3_Analysis.txt”

g. Copy/Paste/Edit until the equation looks like this:

Value at Evaluatio. Value at Last Trigg Output Attribute

Name Expression
Reltime "2/1/2019 12:08:00 AM® + SecSinceChange( Active’) 2/1/2019 12:18:13 | 2/1/2019 12:18:00 | Map ®

IF "Active' = "Active” then

TagVal('\Calcs\Wellness Rx_Reactor_Upper_Limit|Temperature’,Reltime) then "Above Control”

Varisble2 rature’ < Tagval('\Calcs\Wellness Rx_Reactor_Lower_Limit|Temperature',Reltime) then "Below Control” Map ®

*Note “Variable1” has been replaced with “Reltime”
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h. Click Map on the second line and map it to a new attribute called “Batch SPC Status”
and set the Value Type to String

@ Attribute Template Properties x

Save Output History: @ Yes (O No
Batch SPC Status

MName:

Description:

Data Server: HServerit v

Value Type: String N

A Pl Point data reference attnbute template will be created.
| OK | | Cancel |

i. At the bottom left, change the scheduling so that it is set to event triggered only on the
attribute “Temperature”

[ ] Active

Evaluat
vala [«f] Temperature

[] ‘Calcs\Wellness Rx_Reactor_Lower_Limit|Temperature
[] \Calcs\Wellness Bx_Reactor_Upper_Limit|Temperature

K =

Schedulir Trigger on any input

Trigger on | Temperature

b

J.  Click Evaluate to test the Analysis Configuration and Check In once it is complete

[, Check In

¥} v 2] Refresh | ' New Template ~

Search Element Templates £ =

Save all ch < to the Databas
%pm Analysis Templates  Notiication Rule Templates

L]

@ = MName
f8 Reactor Volume
BB TemperatureS..
4 Batch Temp De...

Example Flement:  Wellness R\Chem\Factory 2\RX300

dd s new variable |

Name: Batch Temp Deviation
Description:
Categories:
Analysis Type: (® Expression () Rellup () Event Frame Generation

Enable analyses when created from template

O sac

Evaluate

Name  Expression

Value at Evaluatio Value ot Last Trige Qutput Attribute

ELSE "In Range”

Else "Not Running"

Reltime |'2/1/2019 12:00:@0 AN’ + SecSinceChange('Active') 2/1/2018 1208:25 | 2/1/2019 120800 | Map ‘@
IF “Active’ - "Active” then
(

variabiez IF 'Temperature' > TagVal('\Calcs\Wellness Rx_Reactor_Upper_Limit|Temperature’,Reltime) then "Above Control” In Range InRange | Bateh SBC Status (@)

ELSE TF 'Temperature® < TagVal("\Calcs\Wellness Rx_Reactor_Lower_Limit|Temperature®,Reltime) then "Below Control”

Evaluation Time: 3/11/2019 1:50:25 PM Last Trigger Time: 3/11/2019 1:50:00 PM  Elapsed Evaluation Time: 33ms.

| scheduiing @ Event-Triggered ) Periocic

Trigger on |Temperature -

FwnerPISCHOOL ystudent0

927905 7-971-4e 2e-bB3F-h3801 66396k
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8. Directed Activity — Create an Event Frame and
Notification

8.1 Objective of Activity

Lastly, now that we have a tag for the SPC status, let’s create an Event Frame and Notification to
automatically contact us when the temperature is out of bounds.

8.2 Identify the Tasks

e Open PI System Explorer
¢ Add a PI Analysis for high and low excursions

¢ Add a PI Notification Rule to the Wellness Rx_Reactor template to trigger
when the results of the previous analysis are out of spec

8.3 Create Event Frames

a. While we’re still in Pl System Explorer, Wellness RX_Reactor Template, add a new
Analysis Template

b. Label it something like “Batch SPC Excursion”
Cc. This time make the rule an “Event Frame Generation” Analysis Type
d. Set Event Frame Template to “Batch SPC Deviation”

e. Set the equation to trigger if the attribute we just created is in the “Above Control” or
“Below Control” states:

‘Batch SPC Status’ = “Above Control” or ‘Batch SPC Status’ = “Below Control”

f. Check In. The page should look like this:

Wellness Re_Reactar

General  Attribute Templates Ports  Analysis Templates  Hotification Rule Templates

Name: Batch SPC Excursion
@ @ MName
fiw Batch Runtime
|H Batch SPC Excursion isType: () Expression () Rollup @ Event Frame Generation (1) 50C

fin  Batch Temp Deviation Enable analyses when created from template
0 Daity Dol etinn Creste a new notification rule template for Batch SPC Excursion

Example Element:  Wellness Ri\Chem\Factory 2\RX300

Generation Mode: | Explici Trigger - Event Frame Template: | Batch SPC Deviation

m‘ [ Eluste |
Name Expression True for Severlty Value at Evaluatio Value at Last Trige
B Start triggers

P | \

s:--r’-:_-_:—:a“aa::h SPC Status® = "Above Control” or 'Batch SPC Status' = "Below Control”
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8.4

f.

Create Notifications

While we're still in PI System Explorer, Wellness RX_Reactor Template
Select the “Notification Rule Templates” Tab

Right click and select “New”

Give it a name like “Batch Temperature Deviation”

Select the “Please configure trigger...” link beneath Trigger

Wellness Rx_Reactor )
General Altribute Templates Ports  Analysis Templates  Notification Rule Templstes | |_ =
] — Mame:  [Batch Temperature Deviaton :j
v  Name Criteria Description:
% High Temperature Event Analysis Template = High.. Categories: -

%2 Batch Temperature De... . i
B emperature De.. I:i New ‘,:\ [w] Enable natification rules when created from template

X Delete =2
Aucit Tral Events..
Trigger @) @ Securty. Subscriptions
Please configure trigger criteria for this notification rule template There are currently 0 subscribers to this Notification Rule Template.
A[ View/Edit Subscriptions.
- Manage Formats

Use the Dropdown and select “Batch SPC Excursion” as our Analysis Template

Batch Temperature Deviation - Trigger Criteria I
Criteria Mode @ Analysis () Event Frame Search
A notification wil be triggered when an event frame that matches ail of these ariteria is created by the selected analysis

Referenced Element Template Wellness Rx_Reactar

> Analysis Template Batch SPC Excursion hd
Creste.and use & new analysi template..

Attribute Value
Batch SPC Excursion
High Temp Event

Resend Interval o Secands v | | Choose when to be notified if child event frames are created for multiple trigger conditions
hen the severity is higher than any previsusly true trigger condition

Ronipetten e s© Seconds v hen the severity is higher than the previous true trigger condition

Event Frame can be acknowledged ) When any trigger condition is true

g. Click OK
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9. Directed Activity — Backfill Data

9.1 Objective of Activity

Let’s take this analysis from step 7 and the event frame from step 8 and backfill data to see which

batches have had issues in the past

9.2 Identify the Tasks

¢ Navigate to the Analysis Management plug-in in Pl System Explorer

e Backfill the Analysis

e Backfill the Event Frames

e View results

9.3 Backfill Analyses

a. In Pl System Explorer, select the Management tab from the bottom left

|% Management

b. Select the four “Batch Temp Deviation” Analyses for the Reactors by checking the
boxes next to them

FEEE
G

t‘ r

fisr Wellness Ro\Chem'\Factory 2\RX400
fétd Wellness Rod\Chem'\Factory 2\RX300
ftd wellness Rac\Chem\Factory 1\RX200
fisd  Wellness Rx\Chem'\Factory 1\RX100

[

Batch Temp Deviation
Batch Temp Deviation
Batch Temp Deviation
Batch Temp Deviation

Batch Temp Deviation
Batch Temp Deviation
Batch Temp Deviation
Batch Temp Deviation

c. Inthe upper right, select the “Backfill/lRecalculate” link and set the start time for
1/1/2019 and leave the end time as *

Operations

Enable | Disable selected analyses

Enable | Disable automatic recalculation for selected analyses

Backfill/Recalculate selected analyses

Start | 1/1/2019

End |*

T
=

="
o

What should we do with existing data?

(@) Leave existing data and fill in gaps

() Permanently delete existing data and recalculate

Queue
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d. Pressthe “Queue” button

e. Once that has completed Backfilling, uncheck the previous four Analyses and select the
four EF analyses labelled “Batch SPC Excursion”

(/] < wellness Rx\Chem\Factory Z\RX400 Batch SPC Excursion Batch SPC Excursion
(] H Wellness Rx\Chem\Factory 2\RX¥300 Batch SPC Excursion Batch SPC Excursion
o H Wellness Ra\Chem\Factory 1\R¥200 Batch SPC Excursion Batch SPC Excursion

2 I B e e e e

Backfill these for the same amount of time, after clicking the Acknowledgement

Operations
Enable | Disable selected analyses

Enable | Disable automatic recalculation for selected analyses

Baclfill/Recalculate selected analyses

Start [1;' 1/2019 |‘"n‘|
End |* =

What should we do with existing data?
(@) Leave existing data and fill in gaps
(") Permanently delete existing data and recalculate

1 acknowledge that my selection contains event
frame analyses. Event frames in the time range will
be permanently deleted. This will result in loss of
annotations and acknowledgements associated with
the event frames.

| Queue

g. Navigate to the Event Frames section in the lower left

h. Right Click > New Search and search for all events matching the Event Frame
Template “Batch SPC Deviation” to see which batches in the past were outside of
bounds

Ewvent Frarmes Er

I-r_d Event Frame Searches

R ew | Event Frame Searchd
=1 Transfer Searches # Mewr Search
[l =% TransFer Search 1 . EETEE \

Event Frame Search

x v Search

Criteria

Search: Active Between | [ In Frogress

Search start: 2 v | [ all Descendants

Searchend: [*+1d P | » | cCustom ~

Mame: ‘ % Analysis Name: % Element Mame: X
Categary: <Al ~ | % Template: Batch SPC Deviation v %

g Add Criteria ¥

Results E3

Group by: [] Category [] Template

B 3 B Al Mame Gantt Duration Start Tme  |End Time Description Category Severity Template Primary Element {8 ‘
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10. Self-Paced Activity — Repeat exercise for the
Agitation Attribute

10.1 Objective of Activity

While we used Temperature as our model for the course so far, this same methodology can be used for
any attribute. By using the methods used in sections 4-9, feel free to use whatever remaining time you
have to repeat this process with the Agitation Attribute. Certain steps (Like created the event frames
and the PI Vision display) have already been done and do not need to be repeated.

10.2 Identify the Tasks

e Edit the SQL Queries to use Agitation Instead of Temperature
o Output files into the same folder

e View in Upper and Lower bounds in PI Vision

e Create a new Pl Analysis Expression

e Create a new Pl Event Frame Analysis
o The same template may be used

o Backfill data and find the out of range EFs
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Have an idea how to
improve our products?

OSlsoft wants to hear
from you!

https://feedback.osisoft.com/

A
4
i
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OSlsoft.

> PIWorld

Save the Datel!

OSlsoft Pl World Users Conference in Gothenburg, Sweden. September 16-19, 2019.

Register your interest now to receive updates and notification early bird registration opening.

https://pages.osisoft.com/UC-EMEA-Q3-19-PIWorldGBG-
RegisterYourlnterest RegisterYourlnterest-LP.html? ga=2.20661553.86037572.1539782043-
591736536.1533567354

&: I%sisif}Vorld

GOTHENBURG
Sept. 16 - 19, 2019
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